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BAB III 

PERANCANGAN SISTEM 

 

Sistem alat pemantau level ketinggian air dalam tugas akhir ini 

menggunakan dengan alarm otomatis berbasis arduino, sistem ini 

dirancang dengan tujuan  untuk memantau ketinggian air, yang 

dilanjutkan dengan  ditampilkan pada layar LCD sebagai kepada petugas 

pemantau, sehingga dari sistem tersebut dapat diketahui lebih awal bila 

mana air mulai kering atau dalam batas atas ketinggian, secara tiba-tiba 

alarm pun akan berbunyi dan lampu LED akan ON. Perancangan aplikasi 

relay , menggunakan catu daya adaptor 9 volt yang terhubung langsung 

dari PLN. Sistem alat ini terdiri dari beberapa rangkaian yaitu rangkaian 

perangkat Microcontroller Arduino Uno.  

3.1 Cara kerja Rangkaian 

Ada 2 cara kerja rangkaian untuk proses pembuatan rangkaian level 

ketinggian air, cara pembuatan rangkaian tersebut adalah: 

Rangkaian menampilkan tingkat air di dalam tangki dan switch motor ON 

ketika permukaan air menurun dibawah tingkat yang telah ditentukan. 

Rangkaian otomatis beralih OFF bermotor saat tangki penuh. Tingkat air 

dan data penting lainnya yang ditampilkan pada layar LCD 16 x 2. 

Rangkaian juga memantau tingkat air dalam tangki bah (sump tank) / 

(tangki sumber). Jika tingkat di sisi tangki bah rendah, relay akan beralih 
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ON dan ini melindungi agar tangki tidak kering. Suara bip dihasilkan 

ketika tingkat di tangki bah rendah atau jika terjadi kekeringan. 

Metode kondiktif digunakan untuk mengukur level ketinggian air, 

Sensor perakitan terdiri dari empat probe aluminium diatur ¼, ½, ¾, dan 

tingkat penuh dalam tangki. Ujung kering kabel yang terhubung ke 

analaog input pin A1, A2, A3, dan A4 dari micocontroller rarduino uno 

masing- masing. Sebuah kawat lima diposisikan di bagian bawah tangki. 

Resistor R6 untuk R9 yang pull down resistor. Terakhir kawat kering ini 

terhubung ke 5V DC. Ketika air menyentuh probe tertentu, sambungan 

listrik didirikan antara yang probe dan + 5V penyelidikan karena air 

memiliki konduktivitas. Sebagai mengalir akibat arus melalui 

penyelidikan itu dan saat ini diubah menjadi tegangan yang proporsional 

dengan pull down resistor.  

 

Arduino membaca tegangan turun di setiap pull down resistor untuk 

merasakan tingkat air di dalam tangki. Metode yang sama digunakan 

untuk mengukur tingkat air bah. 

Digital pin 7 dari arduino mengendalikan buzzer dan digital pin 8 

kontrol motor. Transistor Q1 mendorong bel dan resistor R5 membatasi 

arus basis Q1. Transistor Q2 drive relay. Resistor R3 membatasi arus basis 

Q2. D2 adalah dioda freewheeling. POT R2 digunakan untuk mengatur 

kontras LCD, resistor R1 membatasi arus yang melalui lampu LED 

kembali. Resistor R4 membatasi arus yang melalui kekuatan ON LED. 
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Arduino membaca output sensor melalui pin input analog 

menggunakan fungsi analogRead. Misalnya q=analogRead (QUT); 

mengubah tegangan (dalam kisaran 0 sampai 5V) “kuartal” penyelidikan 

ke sejumlah (dalam kisaran 0-1.023) dan menyimpannya ke dalam 

variabel “q”. Dengan cara ini tegangan pada setiap prob dipindai untuk 

variabel yang sesuai.  

 

Variabel ini dibandingkan dengan sejumlah tetap (100 sini) 

untuk mengidentifikasi kondisi saat ini. Sebenarnya 100 adalah setara 

dengan 0,48 volt dan jika tegangan pada sensor tertentu lebih besar dari 

ini, itu dianggap sebagai kontinuitas listrik dan air diasumsikan 

menyentuh probe. Lembah jumlah tetap (perbandingan variabel “v”) 

membutuhkan beberaba penyesuaian karena resistivikasi perubahan air 

dari tempat dan kesenjangan antara probe sensor akan berbeda dalam 

tangki yang berbeda. Rangkaian tersebut  secara garis memiliki dimensi 

12x6 cm seperti gambar berikut ini : 
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Gambar 3.1 Perancangan sistem dan dimensi rangkaian level ketinggian 

air 

 

Dimensi bangunan prototype level ketinggian air adalah 12x6 

Cm, dan box air terdiri dari 2 variable rangkaian yaitu level ¼, ½, ¾, dan 

tingkat penuh dalam tangki. 
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Gambar 3.1: Layout rangkaian Level ketinggian air menggunakan 

microcontroller arduino uno 
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3.2  Struktur pada rangkaian 

Adapun implementasi rangkaian  di atas dapat di lihat dalam 

setruktur seperti  di bawah ini. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar : 3.2  Struktur pada rangkaian level ketinggian air 
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3.3 Koponen Komponen pada rangkaian 

Pada dasarnya, setiap rangkaian memerlukan komponen untuk 

menunjang proses pembuatan rangkaian level ketinggan air.Adapun 

kebutuhan-kebutuhan dari pembuatan rangkaian  ini adalah: 

3.3 Komponen internal 

No Nama Komponen Resistensi Jumlah  

1 Relay - 1 

2 Resistor  10k 5 

3 Resistor  100 ohm 2 

4 Resistor  560 ohm 2 

5 Transistor  2N2222 3 

6 Buzzer - 1 

7 Potensio - 1 

8 LED - 1 

9 LCD 16x2 tipe JHD 162A - 1 

10 Microcontroller Arduino uno - 1 

11 Kabel Standart USB Arduino - 1 

12 Import charges - 1 

13 Bread Board - 1 

14 PCB - 1 

15 Kabel - - 

16 CD-Driver Arduino - 1 
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3.3 Komponen Eksternal 

Nama Komponen Jumlah 

Adaptor 9v-DC 1 

Adaptor 5v-DC 1 

 

3.4 Konversi program microcontroller arduino uno 

Adapun sketch yang di gunakan untuk program 

rangkaian adalah sebagai berikut: 

#include 

<Liquid

Crystal.h

> 

int 

sump=A

0; 

int 

qut=A1; 

int 

hlf=A2; 

int 

thf=A3; 

int 

ful=A4; 

int 

motor=8; 

int 

buz=7; 

int s; 

int q; 

int h; 

int t; 

int f; 

int i;     

//motor 

status 

flag 

int 

v=100; 

//compar

ison 

variable(

needs 

some 

adjustme

nt) 

int b=0;   

//buzzer 

flag 

int m=0;   

//motor 

flag 

int c=0;   

//sump 

flag 
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LiquidCr

ystal 

lcd(12, 

11, 5, 4, 

3, 2); 

 

void 

setup() 

{ 

 

pinMode

(qut,INP

UT); 

pinMode

(hlf,INP

UT); 

pinMode

(qut,INP

UT); 

pinMode

(ful,INP

UT); 

pinMode

(sump,IN

PUT); 

pinMode

(motor,O

UTPUT)

; 

pinMode

(buz,OU

TPUT); 

lcd.begin

(16, 2); 

digitalW

rite(buz,

LOW); 

} 

 

void 

loop() 

{ 

 

i=digital

Read(mo

tor); 

s=analog

Read(su

mp); 

q=analog

Read(qut

); 

h=analog

Read(hlf

); 

t=analog

Read(thf

); 

f=analog

Read(ful

); 

lcd.clear(

); 

 

if(f>v 

&& t>v 

&& h>v 

&& q>v 

) 

{ 
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lcd.setCu

rsor(0,0); 

lcd.print(

char(219

)); 

lcd.print(

char(219

)); 

lcd.print(

char(219

)); 

lcd.print(

char(219

)); 

lcd.setCu

rsor(5,0); 

lcd.print(

"FULL")

; 

m=0; 

b=0; 

} 

else 

{ 

if(f<v 

&& t>v 

&& h>v 

&& q>v) 

{ 

lcd.setCu

rsor(0,0); 

lcd.print(

char(219

)); 

lcd.print(

char(219

)); 

lcd.print(

char(219

)); 

lcd.print(

"_"); 

lcd.setCu

rsor(5,0); 

lcd.print(

"3/4th"); 

b=0; 

} 

else 

{ 

if(f<v 

&& t<v 

&& h>v 

&& q>v) 

{ 

lcd.setCu

rsor(0,0); 

lcd.print(

char(219

)); 

lcd.print(

char(219

)); 

lcd.print(

"_"); 

lcd.print(

"_"); 

lcd.setCu

rsor(5,0); 

lcd.print(

"HALF")

; 
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m=1; 

b=0; 

} 

else 

if(f<v 

&& t<v 

&& h<v 

&& q>v) 

{ 

lcd.setCu

rsor(0,0); 

lcd.print(

char(219

)); 

lcd.print(

"_"); 

lcd.print(

"_"); 

lcd.print(

"_"); 

lcd.setCu

rsor(5,0); 

lcd.print(

"1/4th"); 

b=0; 

} 

else 

{ 

if(f<v 

&& t<v 

&& h<v 

&& q<v) 

{ 

lcd.setCu

rsor(0,0); 

lcd.print(

"_"); 

lcd.print(

"_"); 

lcd.print(

"_"); 

lcd.print(

"_"); 

lcd.setCu

rsor(5,0); 

lcd.print(

"LOW"); 

b=0; 

} 

else 

 

{ 

digitalW

rite(moto

r,LOW); 

lcd.setCu

rsor(0,0); 

lcd.print(

"ERROR

!"); 

b=1; 

} 

}}} 

if(i==HI

GH) 

{ 

lcd.setCu

rsor(0,1); 

lcd.print(

"Motor 

ON"); 

} 
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else 

{ 

lcd.setCu

rsor(0,1); 

lcd.print(

"Motor 

OFF"); 

} 

 

if(s>v 

&& 

m==1) 

{ 

digitalW

rite(moto

r,HIGH); 

} 

if(s<v) 

{ 

digitalW

rite(moto

r,LOW); 

lcd.setCu

rsor(11,0

); 

lcd.print(

"Low"); 

lcd.setCu

rsor(11,1

); 

lcd.print(

"Sump"); 

c=1; 

} 

if(s>v) 

{ 

c=0; 

} 

 

if(m==0) 

{ 

digitalW

rite(moto

r,LOW); 

} 

 

if(b==1 || 

c==1) 

{ 

digitalW

rite(buz,

HIGH); 

delay(50

0); 

digitalW

rite(buz,

LOW); 

} 

else 

{ 

digitalW

rite(buz,

LOW); 

} 

delay(10

0); 

lcd.clear(

);
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3.5 Cara upload program ke arduino 

Arduino Uno, Mega, Deumilanove dan Arduino Nano akan 

menarik sumber daya dari port USB atau power supply eksternal. 

Hubungkan board Arduino dengan komputer menggunakan kabel 

USB. LED berwarna hijau (berlabel PWR) akan hidup. 

1. Instalasi Drivers 

Instalasi driver untuk Arduino Uno dengan Windows 7: 

 Hubungkan board anda dan tunggu Windows untuk 

memulai proses instalasi driver. Setelah beberapa 

saat, proses ini akan gagal, walaupun sudah 

melakukan yang terbaik. 

 Klik pada Start Menu dan buka Control Panel 

 Di dalam Control Panel, masuk ke menu System and 

Security. Kemudian klik pada System. Setelah 

tampilan System muncul, buka Device Manager. 

 Lihat pada bagian Ports (COM & LPT). Anda akan 

melihat sebuah port terbuka dengan nama “Arduino 

Uno (COMxx)” 

 Klik kanan pada port “Arduino Uno (COMxx)” dan 

pilih opsi “Update Driver Software”. 

 Kemudian, pilih opsi “Browse my computer for Driver 

software”. 
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 Terakhir, masuk dan pilih file driver Uno, dengan nama 

“ArduinoUNO.inf”, terletak di dalam folder “Drivers” 

pada Software Arduino yang telah di-download tadi. 

 Windows akan meneruskan instalasi driver. 

Instalasi driver untuk Arduino, Nano atau Diecimila 

dengan Windows 7: 

Ketika anda menghubungkan board, Windows 

seharusnya memulai proses instalasi driver (ini 

apabila anda belum pernah menggunakan komputer 

tersebut dengan board Arduino sebelumnya). 

Pada Windows Vista, driver akan otomatis di-

download dan diinstalasi. 

Pada Windows 7, wizard Add New Hardware akan 

muncul: 

 Ketika ditanya Can Windows connect to Windows 

Update to search for software? pilih No, not this time. 

Klik next. 

 Pilih Install from a list or specific location (Advanced) 

dan klik next. 

 Pastikan bahwa Search for the best driver in these 

location dicentang; Seach removable media jangan 

dicentang; Include this location in the search 

dicentang dan masuk ke direktori drivers/FTDI USB 

Drivers pada folder software Arduino. (Versi terakhir 
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dari driver ini dapat ditemukan pada situs FTDI). Klik 

next. 

 Wizard akan mencari driver dan kemudian 

memberitahu bahwa sebuah “USB Serial Converter” 

telah ditemukan. Klik finish. 

 Wizard hardware baru akan muncul kembali. Ulangi 

langkah yang sama seperti sebelumnya dengan pilihan 

yang sama dan lokasi folder yang sama. Kali ini 

sebuah ” USB Port Serial” akan ditemukan. 

Anda dapat memastikan apakah driver sudah ter-

install dengan membuka Windows Device Manager 

(di tab Hardware pada Control Panel – System). Cari 

“USB Serial Port” pada bagian Ports, itulah board 

Arduino. 

2. Jalankan Aplikasi Arduino 

Klik dua kali pada aplikasi Arduino (arduino.exe). 

3. Buka contoh Blink 

Buka contoh program LED Blink: File > Examples > 

1.Basics > Blink. 

http://www.ftdichip.com/Drivers/VCP.htm
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Gambar : 3.4  uji coba  rangkaian 

 

4.  Pilih board anda 

Anda perlu memilih opsi pada menu Tools > Board 

yang sesuai dengan board Arduino yang dipakai. 
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 Gambar : 3.4  Pemilihan boar ke arduino 

5.  Pilih serial port anda 

Pilih port serial yang digunakan oleh board Arduino 

anda pada menu Tools > Serial Port. Biasanya ini adalah COM3 

atau yang lebih tinggi (COM1 dan COM2 biasanya sudah 

direservasi untuk serial port hardware).  

 



 

 

77 

 

 

Untuk mencari tahu, anda dapat melepaskan koneksi ke 

board Arduino dan buka kembali menu tadi; pilihan yang 

menghilang harusnya adalah board Arduino anda. Koneksikan 

kembali board-nya dan pilih serial port yang sesuai. 

6.  Upload program 

Nah, sekarang hanya tinggal klik tombol “Upload” pada 

software. Tunggu beberapa saat – anda dapat melihat led TX dan 

RX pada board berkelap-kelip. Bila upload berhasil akan ada 

pesan “Done uploading.” yang muncul pada status bar. 

 

 

Gambar : 3.4  Gambar upload uji coba program arduino 

 

Beberapa saat setelah upload selesai, anda dapat melihat 

pin 13 (L) LED pada board mulai berkelap-kelip (warna oranye). 

Jika benar, selamat! Anda sudah berhasil menjalankan Arduino 

dan program-nya dengan sukses. 

3.4. Hasil Upload program Level ketinggian air menggunakan 

Microcontroller arduino 
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3.6 Hasil percobaan upload program 

 

 Hasil upload dengan Error code  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar : 3.6  Hasil Upload program Level ketinggian air menggunakan 

Microcontroller arduino dengan coding yang Error. 

Peringatan 

Eror Code 
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 Hasil upload dengan code yang benar.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar : 3.6 Hasil Upload program Level ketinggian air menggunakan 

Microcontroller arduino dengan coding yang Error 

 

Peringatan 

Coding sudah benar 
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3.7 Diagram flochart Level ketinggian air menggunakan 

microcontroller arduino 
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Gambar : 3.5 Diagram flochart Level ketinggian air 

menggunakan microcontroller arduino 
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Dari diagram flochart di atas dapat di jelaskan sebagai berikut: 

Pertama yang di lakukan start dahulu, Start di sini yaitu persiapan awal 

sebelum melakukan proses berikut.nya seperti menyiapkan komponen 

komponen dan menyiapkan layout. Setelah start kemudian langkah 

berikutnya yaitu installasi data, Installasi data di sini yaitu memulai 

pemasangan komponen komponen kepada rangkaian. Proses selanjutnya 

yaitu Outpout. Outpot disini berupa keluaran dari komponen komponen 

yang sudah di aliri arus tadi, sehingga harus di lakukan pengecekan untk 

memastikan bahwa komponen berfungsi dengan baik.  

Apabila pengujian komponen ada yang tidak mengeluarkan arus 

maka kembali ke proses start, dan apabila sebalik.nya maka bisa lanjut ke 

langkah langkah berikutnya yaitu proses, setelah proses tidak mengalami 

masalah maka di lakukan pengujian, pengujian ini berarti menguji semua 

komponen baik yang terdiri dari komponen hardware maupun software. 

Setelah di lakukan pengujian maka bisa di lihat dalam tampilan outputnya, 

pengecekan menggunakan komputer apabila masih ada kesalahan maka 

output akan ada tampilan eror,, Kalau proses pengujian sudah selesai dan 

hasilnya tidak mengalami masalah maka proses selesai. 


